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This program is free software: you can 
redistribute it and/or modify it under the 
terms of the GNU General Public License 
as published by the Free Software 
Foundation, either version 3 of the 
License, or (at your option) any later 
version. 
 
This program is distributed in the hope 
that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied 
warranty of MERCHANTABILITY or 
FITNESS FOR A PARTICULAR PURPOSE.  
See the GNU General Public License for 
more details. 
 
You should have received a copy of the 
GNU General Public License along with 
this program.  If not, see: 

https://www.gnu.org/licenses/ 
 
Disclaimer of Warranty: 
THERE IS NO WARRANTY FOR THE 
PROGRAM, TO THE EXTENT PERMITTED 
BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE 
COPYRIGHT HOLDERS AND/OR OTHER 
PARTIES PROVIDE THE PROGRAM “AS 
IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE PROGRAM IS 
WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE 
COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION. 

 
 

 

Limitation of Liability: 

IN NO EVENT UNLESS REQUIRED BY 

APPLICABLE LAW OR AGREED TO IN 

WRITING WILL ANY COPYRIGHT 

HOLDER, OR ANY OTHER PARTY WHO 

MODIFIES AND/OR CONVEYS THE 

PROGRAM AS PERMITTED ABOVE, BE 

LIABLE TO YOU FOR DAMAGES, 

INCLUDING ANY GENERAL, SPECIAL, 

INCIDENTAL OR CONSEQUENTIAL 

DAMAGES ARISING OUT OF THE USE 

OR INABILITY TO USE THE PROGRAM 

(INCLUDING BUT NOT LIMITED TO LOSS 

OF DATA OR DATA BEING RENDERED 

INACCURATE OR LOSSES SUSTAINED 

BY YOU OR THIRD PARTIES OR A 

FAILURE OF THE PROGRAM TO 

OPERATE WITH ANY OTHER 

PROGRAMS), EVEN IF SUCH HOLDER 

OR OTHER PARTY HAS BEEN ADVISED 

OF THE POSSIBILITY OF SUCH 

DAMAGES. 
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About This Guide  

 

 
  

 
Abstract 

aXonica is a free, easily distributable software installation package for freeware tools 
related to Bioimaging especially in the field of Magnetic Resonance Imaging (MRI).  
 
aXonica is a Linux-based installation package that downloads and installs the tools 
related to Magnetic Resonance Imaging (MRI) as per user requirement. It also downloads 
the dependencies prior to the tools for which they are required. aXonica also provides an 
interactive user interface which is easily understandable for users unaware of UNIX-shell 
language. 
 
 

Purpose 

The basic purpose of this document is to provide the complete description about the 
installation of aXonica shell file as well as the complete working of aXonica-UI. This 
document also explains the complete pipeline of MRI tools; also shows how this pipeline 
is implemented in the installation package. 
 
 

Intended Audience 

This document is intended for users who wish to install the tools related to Magnetic 
Resonance Imaging on Linux-based operating system. 
 
 

Required Background 

Team aXonica has made every attempt to make this a step by step guide. However, some 
familiarity with Linux operating system as well as software and hardware requirements of 
aXonica are assumed. 
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How This Guide is Organized 

This guide is organized into sections grouped according to the intended use by the user: 

 About This Guide (Chapter 1) describes this document’s purpose and intended 
audience. 

 Software Installation Process (Chapter 2) describes how to install aXonica. 

 Data Acquisition and Software Pipeline (Chapter 3) describes the acquisition of raw 
data image of MRI machine and implementation of software pipeline of Biological 
image development. 

 Tutorial Datasets (Chapter 4) describes how to download tutorial datasets. 

 Image Preprocessing (Chapter 5) describes the step by step solution to 
recommended software. 

 Image Processing (Chapter 6) describes the step by step solution to recommended 
software. 

 Structural Analysis (Chapter 7) describes the step by step solution to 
recommended software. 

 Data Management & Annotation (Chapter 8) describes the step by step solution to 
recommended software. 

 aXonica-UI (Chapter 9) describes the step by step working of user interface. 

 Software Uninstallation Process (Chapter 10) describes how to install aXonica or 
any specific tools. 

 
 

Contact 

For any further queries and suggestions, contact us at: hasaniqbal777@gmail.com 
 

  

mailto:hasaniqbal777@gmail.com
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Software Installation Process 
 

 

 

 

 

Installing aXonica software 

For downloading of aXonica, visit its website:  

https://github.com/hasaniqbal777/aXonica 

1. Make aXonica Resource Folder in your drive and put the shell file of aXonica in this 

folder. 

2. Run the terminal and cd to the Resource folder. 

3. Now run the following commands on terminal: 

> chmod +x aXonica-v3.0.sh 

> sudo bash aXonica-v3.0.sh 

4. Installation wizard of aXonica will start.  

NOTE  Installation of aXonica require a proper internet connection to proceed, otherwise 

the installation terminates. 
 

 
Figure 1: Installation Welcome screen 

 
 

https://github.com/hasaniqbal777/aXonica
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5. Click Next to proceed and confirm the Internet connection.  
 

 
Figure 2: Internet check successful screen 

6. Installation is terminated if there is no internet.  
 

 
Figure 3: Internet check failed screen 

7. Dependencies related to software will start installing.  
 

 
Figure 4:Dependencies Installation in progress screen 
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8. All the dependencies which are installed are displayed at the end of the installation. 

Click Ok. 
 

 
Figure 5: Dependencies Installation finished screen 

9. aXonica pipeline detail screen is displayed. It has the information about which 
software you want to install. Click Next to Proceed.  

 

 
Figure 6: Pipeline information screen  
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10. Click Next to proceed with the installation.  
 

 
Figure 7: Ready to Install screen 

11. Selection screen for Preprocessing tools is displayed. Select the required tools and 
Click Next.  

 

 
Figure 8: Preprocessing tools selection screen 
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12. Selection screen for Processing tools is displayed. Select the required tools and Click 

Next.  
 

 
Figure 9: Processing tools selection screen 

13. Selection screen for Structural Analysis tools is displayed. Select the required tools 
and Click Next.  

 

 
Figure 10: Structural Analysis tools selection screen 
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14. Selection screen for Data Management and Annotation tools is displayed. Select the 

required tools and Click Next.  
 

 
Figure 11: Data Management and Annotation selection screen 

15. Tools installation will continue. Some tools install as a standalone installation and will 
be called automatically.  

 

 
Figure 12: Tools installation progress screen 
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16. Software will be automatically download from the aXonica repository online. 

Downloading time depend upon your Internet.  
 

 
Figure 13: Tools downloading in background 

17. Installation of aXonica is now finished. Click Finish to use the Tools.  
 

 
Figure 14: Finalizing Installation screen 
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Data Acquisition and Software 

Pipeline 

 

 
 

 

In this Chapter 

We will learn about: 

 Image Data Acquisition  

 MRI network diagram in hospitals 

 Introduction to software pipeline 

 

Introduction 

Medical Imaging Technology is identified globally by some major diagnostic imaging 

device manufacturers. Honorable mentions contain Fujifilm Holdings, Siemens Healthcare, 

Toshiba Medical Systems Corporation and Canon Medical Systems Corporation. 

MRI machine is installed and distributed with some extra workstation for functionality i.e. 

 Scan Console 

 Display Console 

 Reconstruction Box 

 Quality Control (Calibration Phantoms) 
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Image Data Acquisition from MRI 

MRI installation network diagram is given as follows: 

 

Figure 1: MRI network diagram 
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STEP 1: 

In the first step, the Scan Console is given commands by the user about which part of 

the human body is about to be analyzed. 

 

STEP 2: 

These commands are transferred to the MRI and patient data is acquired. This raw data 

is in K-space (frequency domain). 

 

STEP 3: 

The data is then sent to the Scan Console which further sends this data to the 

reconstruction box. This raw data is stored in Raw Data Disk (RDD). 

 

STEP 4: 

Inside the reconstruction box, Fourier analysis is performed on the data and thus it is 

converted into time domain. 

 

 

 

 

 

The output, known as Image Data received from the transform is saved in Image Data 

Disk (IDD). 

STEP 4: 

The image data acquired from IDD is then transferred to Display Console for further 

processing. 

 

STEP 6: 

Now the data present in Display Console is further transferred to aXonica 

workstation which has all freeware tools installed in it. Any operation can be performed 

according to user’s request. 
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Software Image Pipeline 

MRI software base is divided into several steps. These steps are visualized using a 
pipeline so that the tools can be accessed according to user’s needs. aXonica contains 
several tools from each category. 

 

Figure 2: MRI Pipeline Visualized 
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Tutorial Datasets 
 

 

 

 

 

Downloading aXonica Tutorial Datasets 

aXonica tutorial datasets is available at its website: 

https://github.com/hasaniqbal777/aXonica 

1. Put the tutorial datasets shell file in the already created aXonica Resource Folder in 

your drive. 

2. Run the terminal and cd to the Resource folder. 

3. Now run the following commands on terminal: 

> chmod +x aXonica-tutorial-datasets.sh 

> sudo bash aXonica-tutorial-datasets.sh 

4. Download wizard of tutorial datasets will start.  

NOTE   Download tutorial datasets require a proper internet connection to proceed, 

otherwise the installation terminates. 
 

 
Figure 1: Welcome screen 

 
 
 

https://github.com/hasaniqbal777/aXonica
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5. Click Next to proceed and confirm the Internet connection.  
 

 
Figure 2: Internet check successful screen 

6. Installation is terminated if there is no internet.  
 

 
Figure 3: Internet check failed screen 

7. Select the tutorial datasets you want to download.  
 

 
Figure 4: Tutorial Datasets selection screen 
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8. Click Next to proceed with the Download.  
 

 
Figure 5: Ready to Download screen 

9. Tools downloading will continue.  
 

 
Figure 6: Download progress screen 
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10. Download of Tutorial Datasets is now finished. Click Finish to use the Tools.  
 

 
Figure 7: Finalizing Installation screen 
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Image Preprocessing 

 

 
 

 

In this Chapter 

We will learn about: 

 Image Preprocessing 

 Steps for Preprocessing 

 Recommended tools for Preprocessing 

 

Introduction 

Pre-processing concerns the improvement of the Image Data and it enhances some image 

features that are important for further processing.  

Image Preprocessing has three significant steps: 

 Image Visualization 

 Image Enhancement 

 3D Image Reconstruction 
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Image Visualization 

Raw data is acquired from MRI Scanner. The images acquired are in the frequency domain. 
Specific Fourier analysis converts the “Raw Data” into “Image Data” which is in time 
domain. It is further pre-processed and transferred for imaging. 

Recommended tool   ImageVis3D 

ImageVis3D [1] 

An architecture for Large Scale Volume Rendering: Provides domain specific visualization 
capabilities.  

1. Open terminal and run these commands: 

> cd /usr/local/imageVis3D-3.1.0 

> ./imageVis3D 

2. Select “Open data set from file”  
 

 
Figure 1: ImageVis3D Welcome screen 

  
 
 
 
 
 
 
 
 
 



a   onica       User Guide 
 

20 
 

3.0 X 

 
 
 

3. Load the downloaded dataset  

 
Figure 2: Visualized Image           

4. Further Analyze the image.  
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Image Enhancement 

Brightness of specific parts of body (e.g. Brain, Spine etc.) is adjusted so that the results 
are more suitable for display and further image analysis. 

Recommended tool  AMIDE 

AMIDE [2] 

A Free Software Tool for Multimodality Medical Image Analysis: Displays and analyzes 
multimodality volumetric medical images. 

1. Run the following commands in the terminal: 

> export UBUNTU_MENUPROXY=0 

> amide 

2. AMIDE “New Study” screen opens: 

 

 
Figure 3: AMIDE Welcome screen 

3. File → Open Study 

4. Load the downloaded tutorial dataset file: m2862-small.xif 

 
Figure 4: Enhanced Images 

5. Further Analyze the image. 
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3D Image Reconstruction 

Visualized images are processed and several images are aligned and converted to 
separate Axial, Coronal and Sagittal planes of the visualized part of body. 

Recommended tool  ITK-SNAP 

ITK-SNAP [3] 

Allows users to segment structures in 3D medical images. ITK-SNAP provides semi-
automatic segmentation using active contour methods, as well as manual delineation and 
image navigation.  

1. Run the following commands in the terminal:  

> cd /usr/local/itksnap-3.6.0-20170401-linux-x86_64 

> cd /bin 

> ./itksnap 

2. File →   Open main image →   Browse 

 
Figure 5: ITK-SNAP Welcome screen 
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3. Load data set from file: 

 
Figure 6: 3D Reconstructed Image  

4. Further Analyze the image 
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Image Processing 

 

 
 

 

In this Chapter 

We will learn about: 

 Image Processing 

 Steps for Processing 

 Recommended tools for Processing 

 

Introduction 

Image processing refers to processing or altering an existing image in a desired manner. 

Image Processing has three significant steps: 

 Image Segmentation 

 Image Registration 

 Image Surfacing 
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Image Segmentation 

It is a process of partitioning a digital image into multiple segments which are more 
meaningful and easier to analyze. For Example: A Brain MRI image is segmented into 
several images for visualization and analyses of gray matter, white matter and 
cerebrospinal fluids. 

Recommended tool  BrainSeg3D 

BrainSeg3D [4] 

Provides a free volume (3D image) viewer and segmentation tool. BrainSeg3D is a graphic 
application that make segmentation of volumes more accurate by providing tools for 
semi-automated segmentation combined with a user friendly graphic interface. 

1. Run these commands in the terminal:  

> cd /usr/local/brainseg3D 

> ./BrainSeg3D 

2. Select ‘Quick open file’ 

 

 
Figure 1: BrainSeg3D Welcome Screen 

3.    Load Tutorial data sets 
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4.    Select all Images and Import 

 
Figure 2: Segmented Image 

5.    Further Analyze the image 
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Image Registration 

Process of transforming different sets of data into one coordinate system.  

Standard Co-ordinate system for DICOM images is 512 x 512-pixel resolution. This provides 
a standard base for patient imaging. It is very helpful in reporting of the patient to have a 
standard pixel ratio. 

 
Figure 3: Image Registration 

Recommended tool  Mango 

Mango [5] 

A complete data analysis pipeline that provides statistical confidence estimates for 
interactions and corrects for major sources of bias including differential peak enrichment 
and genomic proximity. 

1. Run the following commands in the terminal: 

> cd /usr/local/Mango 

> ./mango 

2. Select Open. 

 
Figure 4: Mango Welcome screen 
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3. Open the Tutorial Dataset downloaded. 

 
Figure 5: Registered Image 

4. Further Analyze the image according to needs. 
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Image Surfacing 

Process in which a 3D view of the Image Data is created and visualized. 

Recommended tool  BrainVISA 

BrainVISA [6] 

Neuroimaging Research Software Hosts heterogeneous tools dedicated to neuroimaging 
research.  

1. Run the following commands in the terminal: 

       > cd /brainvisa-4.5.0 

       > ./anatomist 

 
Figure 6: Anatomist Welcome screen 

2. File → Open 

3. Load the downloaded tutorial dataset file: 

 T1 MRI: data_for_anatomist/subject01/subject01.nii  

 Activation map: data_for_anatomist/subject01/Audio-Video_T_map.nii  

4. Select the 2 objects in the object list using Ctrl + left button 

5. Click on the fusion button   
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6. A new window is displayed which allows to select some fusion parameters. 
 

 
Figure 7: Fusion type selection screen 

7. Click OK to create the fusion object 

 
Figure 8: Fusion object screen 
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8. Open an axial window by clicking on   

9. Put the object (the fusion volume) into this window: drag and drop this object into the 
window. Following non registered image will appear 
 

 
Figure 9: Fused mismatched image 

10. For each volume, right-click.    

11. Referential → Load information from file header 

NOTE  The option Referential → Load information from file header extracts information 

about referential and transformations which are stored in the image files i.e. automatic 

registration. 

12. Look at the fusion, the 2 images are now well superimposed. 

NOTE  Manual registration can also be done but in fact the human eye cannot drive a 

registration as well as a specific algorithm. For instance, images may seem aligned in an 

axial slice, but contain some drifts in sagittal and coronal orientations. 
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In this Chapter 

We will learn about: 

 Structural Analysis 

 Steps for Structural Analysis 

 Recommended Tools for Structural Analysis of Images 

 

Introduction 

Structural analysis of an image refers to the extraction of meaningful information from the 

image by means of several techniques. 

Structural Analysis has seven significant steps: 

 Brain Connectomics 

 Modelization 

 Morphometric Analysis 

 Quality Control 

 Classification 

 3D Image Analysis 

 Image Mapping 
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Brain Connectomics 

Brain Connectomics is the production and study of connectomes. Connectomes are 
comprehensive maps of connections within an organism's nervous system. Brain 
Connectomics Analysis is divided into two types: 

 

 

 

Diffusion Analysis is done by analyzing the diffusion of water molecules in tissues. 

Diffusion coefficient reduces for the cancerous tissues which is visualized. 

 

Perfusion Analysis is done by analyzing the amount of blood taken up in certain areas of 

your brain. This can provide information on how your brain is functioning. Damaged areas 

have less oxygen and glucose use hence less blood supply which is visualized. 

 

 

 

 

 

 

 

 

Recommended tool  medInria 

 

 

 

 

 

 
 

 

(b) Perfusion Analysis (a) Diffusion Analysis 

Figure 10: Comparison Between Diffusion and Perfusion Analysis 
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medInria [7] 

Research and visualize medical images: medInria is a platform for the diffusion of research 
software in medical imaging created by medInria teams. 

1. Run the following commands on the terminal:  

> cd/usrlocal/medinria-2.2.3-linux_x86_64 

> cd/bin 

> ./medInria_launcher.sh 

2. Select Diffusion 

 
Figure 11: medInria Welcome Screen 

5. Select “Open a file from your system”. 

 
Figure 12: Load Study screen 
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5. Select the downloaded tutorial dataset file:  xDTICUBE-4D.nii.gz  

 

In the Model Estimation tab,  

6. Select the Estimation Algorithm as DTI estimation 

7. Select the gradient file:  gradient7.txt 

 
Figure 13: Model Estimation 

8. Select Estimate model and wait for the diffusion analysis of the image 

 

 
Figure 14: Diffusion Estimated Image 

9. Further Analyze the Image according to needs. 
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3D Image Analysis 

3D image analysis is the extraction of specific part of body from 3D visualized images 
which can be analyzed. For Example: 3D Analysis of Circle of Willis inside the brain. 

Recommended tool   ImageJ 

ImageJ [8] 

Biological Image Analysis: Provides easy installation on arbitrary platforms and a simple 
user interface. 

1. Run the following commands in the terminal:  

> cd /usr/local/ImageJ 

>./ImageJ 

2. File → Open 

 

 
Figure 15: ImageJ Welcome Screen 

3. Select the downloaded tutorial datasets: t1-rendering.zip 
 

 
Figure 16: 3D Analyzed Image 

4. Further Analyze the image according to needs 
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Morphometric Analysis 

It is visualization of the outer surface of the part of body under analysis. 

Recommended tool   FracLac 

FracLac [9] 

NOTE   It is an ImageJ plugin, and it is executed from ImageJ. 

1. Run these commands in the terminal: 

> cd ~/Package/Plugins 

NOTE   This is the resource folder of aXonica-master where the tools are downloaded.  

> sudo cp Frac_Lac.jar /usr/local/ImageJ/plugins 

NOTE   Provide the password for administrator.  

> cd /usr/local/ImageJ 

> ./ImageJ 

2. File → Open 

 

 
Figure 17: ImageJ Welcome Screen 

3. Select the downloaded tutorial datasets: testimage.gif 
 

 
Figure 18: Sample Image 
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3. Select “BC” 

 

 
Figure 19: FracLac Welcome screen 

4. Select OK 

 

 
Figure 20: Mode Selection 

5. Select OK 

 

 
Figure 21: FracLac settings screen 
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6. Select OK 

 

 
Figure 22 Colour Coding Selection screen 

7. Select Scan 

 

 
Figure: 23 Ready to scan 

NOTE   Wait for the image to be processed. 

8. Further Analyze the image according to needs. 

 

Figure 24: Analyzed Image 
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Image Classification 

Different types of tumors and diseases are classified separately in this step. 

Recommended tool   LA-iMageS 

LA-iMageS [10] 

A software for elemental distribution bioimaging: Provides easy installation on arbitrary 
platforms and a simple user interface. 

1. Run the following commands in the terminal: 

> cd /usr/local/LA-iMageS-1.1.5 

> ./run.sh 

2. Select data directory of downloaded tutorial datasets:  

/coin 

/seed 

         
Figure 25: Load Dataset screen 

3. Select OK. 

 
Figure 26: Analyze the Images 
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NOTE   Wait for the image to be processed. 

 

 
Figure 27: Analysed Image 

 
4. Further Analyze the image. 
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Image Mapping 

Optimization of images according to T1-weighted and T2-weighted images standards. In T1 
images only fat is bright while in T2 images both fat and water is bright. Both of these 
standards are used for specific analysis. 

 

 

 

 

 

 

 

Recommended tool   MRI Processor 

MRI Processor [11] 

Computes parametric maps in magnetic resonance (MR) images: MRI Processor provides 

different mechanisms to distinguish different tissues and disease processes. 

NOTE   It is an ImageJ plugin, and it is executed from ImageJ. 

1. Run these commands in the terminal: 

> cd ~/Package/Plugins 

NOTE   This is the resource folder of aXonica-master where the tools are downloaded.  

> sudo cp mri_processor_.jar /usr/local/ImageJ/plugins 

NOTE   Provide the password for administrator.  

> cd /usr/local/ImageJ 

> ./ImageJ 

2. File → Open 

 

 
Figure 29: ImageJ Welcome Screen 

 

 

(b) T2 weighted image (a) T1 weighted image 

Figure 28: Comparison Between T1 and T2 weighted images 
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3. Select the downloaded tutorial datasets: subject01.nii 

 
Figure 30: Sample Image 

4. Select Plugins → MRI Processor 

 

 
Figure 31: Mapping selection 

5. Select Map type as T1 exponential. Click OK  

6. Following Mapped Images appear: 

 

     
Figure 32: Mapped Images 
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7. Following are the Logs for Image Mapping: 

 

 
Figure 33: Mapping Logs 

8. Further analyze the Image 
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In this Chapter 

We will learn about: 

 Data Management and Annotation  

 Steps for Data Management and Annotation 

 

Introduction 

Refers to the transmission of DICOM image file over networks as well as extracting data 

from DICOM files and converting it to other formats. 

Data Management and Annotation has two significant steps: 

 Image Format Management 

 DICOM File Management 
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Image Format Management 

Concerns the transmission of DICOM image file over networks. 

Recommended tool  MRIcron  

MRIcron [12] 

An image viewer for neuroimaging data: MRIcron is a platform able to support multiple 
layers, draw an identified region of brain injury, view data volume rendering and computes 
statistical results. 

1. Run the following commands in the terminal: 

> cd/usr/local/mricron_lx 

> ./mricron 

 
Figure 1: MRIcron Welcome screen 

2.    Further Analyze the image 

NOTE  It is a demo software and it is only used to set the Data Image Formats and test 

them using a Reconstruction environment. 
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DICOM File Management 

Deals with the extraction of data from DICOM files and their conversion into other formats.  

Recommended tool  WEASIS 

WEASIS [13] 

Allows users to view clinical images: WEASIS is a software consisting of a multipurpose 
web-based viewer and dealing with digital imaging and communications in medicine 
(DICOM) dataset. 

1. Run the following commands in the terminal:  

> cd /usr/local/weasis 

> ./viewer_linux.sh 

2. File → Open → DICOM 

 

 
Figure 2: WEASIS Welcome screen 
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3. Provide path for the DICOM file. 
 

 
Figure 3: Import DICOM 

4. Select “Import”. 
 

 
Figure 4: DICOM Image 

5. Further Analyze the image. 
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aXonica-UI Application 

 

 
 

 

In this Chapter 

We will learn about: 

 aXonica graphical user interface  

 Benefits for users unware of UNIX language 

 

Introduction 

The users who have a difficulty in understanding shell script don’t have to learn anything 

about it because aXonica-UI provides an interactive interface for the users. It is basically 

developed using Qt programming that runs shell file in the background.    
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Configuration of aXonica-UI Application 

aXonica–UI is downloaded along with the shell file of aXonica. After installation, a desktop 

icon is created like this: 

 
Figure 1: aXonica-UI desktop icon 

1. Double click the icon. The following screen appears: 

 
Figure 2: Main portfolio screen 
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2. Click on the category you wish to select (say Image Preprocessing). The following screen 

appears: 

 
Figure 3: Sub portfolio screen 

NOTE   To go to the previous screen click  

3. After selecting the required category, the following screen appears: 

 
Figure 4:Tool selection screen 

4. Click on your required software to run. 

NOTE   The buttons of the tools that were not downloaded by the user are disabled. 

 
The procedure of running tools of other categories also proceeds in the same manner. 
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Uninstalling aXonica software 

For downloading of aXonica uninstaller, visit its website:  

https://github.com/hasaniqbal777/aXonica 

1. Put the tutorial datasets shell file in the already created aXonica Resource Folder in 

your drive. 

2. Run the terminal and cd to the Resource folder. 

3. Now run the following commands on terminal: 

> chmod +x aXonica-v3.0-uninstaller.sh 

> sudo bash aXonica-v3.0-uninstaller.sh 

4. Uninstallation wizard of aXonica will start.  

 

 
Figure 1: Uninstallation Welcome screen 

 

NOTE   Software which are not installed also appear in the uninstaller selection screens. 

Selecting/Deselecting them has no effect on uninstallation process. 
 
 

https://github.com/hasaniqbal777/aXonica
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5. Selection screen for Preprocessing tools is displayed. Select the required tools and 

Click Next.  
 

 
Figure 2: Preprocessing tools selection screen 

6. Selection screen for Processing tools is displayed. Select the required tools and Click 
Next.  

 

 
Figure 3: Processing tools selection screen 
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7. Selection screen for Structural Analysis tools is displayed. Select the required tools 
and Click Next.  

 

 
Figure 4: Structural Analysis tools selection screen 

8. Selection screen for Data Management and Annotation tools is displayed. Select the 
required tools and Click Next.  

 

 
Figure 5: Data Management and Annotation selection screen 
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9. Click Next to proceed with the uninstallation.  
 

 
Figure 6: Ready to uninstall screen 

10. Tools uninstallation will continue.  
 
11. Uninstallation of aXonica is now finished. Click Finish to continue. 
 

 
Figure 7: Finalizing Uninstallation screen 
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